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AllenCAD Pro 7.2 
Professional and Affordable CAD For  

Windows XP, Vista, Windows 7 
 

 
 
 

Installation and Getting Started Guide 
 
 
This guide contains important information on installing and getting started with AllenCAD. Please read 
this document in its entirety before using the program for the first time. 
 
NOTE: Detailed program operation is contained in the system’s built-in help. Refer to “Additional Help 
Resources” for information on print-ready user manuals (requires Adobe Acrobat® reader) and extended 
online help resources including tutorials, training movies and users forums. 
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WELCOME TO ALLENCAD PRO 7 

AllenCAD® Pro 7 is designed for businesses and individuals who want a powerful, fast, efficient and 
easy-to-use 2 and 3-dimensional computer-aided design and drafting system for Windows® desktop and  
laptop computers. AllenCAD Pro 7 is a professional-grade CAD system that offers power and versatility 
similar to programs such as AutoCAD® by Autodesk, Inc. or MicroStation® by Bentley Systems, Inc., for 
a fraction of the price.  
 
AllenCAD Pro 7 is an ideal choice for new CAD users, and a perfect industry-compatible solution for 
enterprises seeking to deploy additional CAD licenses to work in harmony with AutoCAD and other 
leading CAD systems. Whether you’re a novice user or a seasoned CAD professional, you’ll soon be 
producing high-quality results using the rich feature set and extensive customization and collaboration 
capabilities of AllenCAD Pro 7.  
 
AllenCAD Pro 7 features unrivalled compatibility with AutoCAD®, featuring instant usability for AutoCAD 
familiar operators, easy learning for non-AutoCAD familiar users, direct reading and writing of industry-
standard DWG® and DXF® drawing files (supports R12 – R2005 formats), the ability to publish and view 
web-ready DWF® (design web format) files, user-selectable and customizable AllenCAD and AutoCAD-
style user profiles, nearly 400 standard and advanced 2 and 3-dimensional design and drawing functions, 
time-saving viewing, markup and collaboration features (including freehand redlining, inspection lists and 
VoiceNOTE™ audio note keeping), instant interface customization using the built-in DME2™ visual 
dialog, menu and toolbar editor, and unlimited system extension using Lisp, C++ or Delphi application 
programming interfaces (APIs). 
 
For mobile users, AllenCad Pro 7 features on-site “point and shoot” creation of as-built floor plans and 
construction drawings using a Leica DISTO™ or Hilti PD 25/28 handheld laser connected to a laptop or 
XP tablet PC.  
 

PICK THE RIGHT ALLENCAD SOLUTIONS FOR YOUR BUSINESS 

AllenCad Pro 7 is part of a complete line of industry-compatible “AllenCAD Anywhere” 2D and 3D design, 
viewing and mobile/wireless collaboration solutions – each designed to save you time and money in the 
office, in the field, or on the shop floor. 

Windows Desktop and Laptop Solutions: 

Combine AllenCad Pro 7 with AllenCAD 7 Viewer™,and other plug-ins and industry-specific solutions to 
address the specific needs and technical abilities of everyone in your organization. From instantly usable 
viewing and markup solutions, to automated industry-specific productivity solutions, there’s a AllenCAD 
desktop or laptop system that’s right for you.  
 
For more information on these and other productivity enhancing solutions, contact ADSI (800) 258-6360 
or visit http://www.adsi-usa.com/. 

WHAT’S NEW IN ALLENCAD PRO 7  

 New AutoCAD R2004/2005 DWG® and DXF® Compatibility - AllenCad Pro 7 provides unrivalled 
compatibility with AutoCAD and other leading systems, with direct reading and writing of AutoCAD 
DWG and DXF files from R12 to the latest R2005 formats (with “round-trip” retention of all objects).   

 New DWF® Publishing With Redistributable Viewer - AllenCad Pro 7 exports results in precise, 
lightweight web and e-mail ready DWF (design web format) format for review by others. AllenCad Pro 
7 also includes a stand-alone DWF viewer which can be freely distributed to other people in your 
organization to collaborate on your project drawings (redistribution restrictions apply). 



AllenCAD® Pro 7 – Installation and Getting Started Guide 

©2006 ADSI. All trademarks property of their respective owners. All Rights Reserved.                      Pg. 3 of 3 
 

 New ACIS 3D Solids Viewing and Rendering – AllenCad Pro 7 includes Spatial Technologies’ 
ACIS™ viewing engine, ensuring accurate representation of 3D solids saved in this popular format. 
Solids can be rendered and output using AllenCAD’s built-in rendering and print/plot tools. 

 New Windows MFC Multiple-Document Interface With OLE and ActiveX – AllenCad Pro 7’s new 
Microsoft-standard interface with Object Linking and Embedding (OLE) functionality and ActiveX 
extensibility delivers amazing power and flexibility, with insertion and in-place editing of files and 
objects from leading applications like Word and Excel. 

 New Customizable User Profiles – Use the included AllenCAD or AutoCAD user profiles, or use the 
QPROFILE command to create and save custom profiles containing your own menus, dialogs, 
toolbars, mouse controls and more. Improve productivity by working exactly the way you want! 

 New High-Speed Editing With Grips And Form-Based Property Editing – Quickly and easily 
modify drawing objects using grips and a new form-based property editor. 

 New Docking Toolbars - AllenCad Pro 7 features dockable and fully customizable toolbars for 
maximum productivity. 

 New Drawing Objects - AllenCad Pro 7 adds complex line types, leaders, tolerances, and many 
other objects unsupported in previous releases. 

 New Inspection Lists – Create detailed inspection/task lists, containing text and/or VoiceNOTE™ 
audio-recordings. Assign tasks to others, “red flag” critical areas, and import or export from Word, 
Notepad and other text editing systems. 

 New Digital Signatures – Insert unique digital signature “stamps” into drawings to ensure the right 
person has signed off. 

 Enhanced EnterPoint Data Entry System – AllenCad Pro 7 features new, dialog-based entry of 
angles, distances and coordinates, facilitating high-speed, “point-and-click” drawing and design. 

 New Visual Dialog Menu and Toolbar Editor  – Customize AllenCad Pro 7 any way you like using 
the new DME2™ visual dialog, menu and toolbar editor. No programming experience required! 

 New Mobile, As-Built Floor Plan Creation With Laser Support – Connect a wired or wireless Leica 
DISTO™ or a Hilti PD 25/28 portable laser measuring device to an XP tablet or laptop PC and you 
have a mobile/wireless design station able to produce laser-drafted, on-site floor plans in record time. 
Increase productivity up to 10 times over manual methods  

 Enhanced Raster Image Support – Save time and money using the new IMAGE function, allowing 
importing and manipulation of multiple raster images directly inside your CAD drawings (scanned 
drawings, digital camera photographs, aerial images, etc.). Images can be scaled, copied, moved or 
edited. Supports popular formats, including BMP, PNG, JPG, RLC and TIF (including GeoTIFF). 

 New Lisp, C++ and Delphi Application Programming Features – AllenCad Pro 7 features dozens 
of new and powerful programming extensions, with a completely new open-architecture design which 
allows programmers to create applications and system extensions in a multi-threaded, ActiveX 
environment (eg. run different applications in different windows at the same time). 

 New FxRAY™ 3D Rendering and Animation (added cost plug-in) – Create powerful rendering, 
raytracing and animation, with materials, textures and lighting for photo-realistic 3D results. 

ADDITIONAL ALLENCAD PRO 7 SYSTEM HIGHLIGHTS 

 Full imperial or metric program operation. 
 Fast and easy to use, with default AllenCAD or optional AutoCAD style interfaces. 
 Produce professional quality 2D and 3D results using over 360 design, drawing and editing functions. 
 AutoCAD-compatible command line entry with 1-3 character command alias shortcuts. 
 Powerful viewing and markup tools with built-in redlining and freehand sketching tools. 
 Hands-free VoiceNOTE™ audio note-keeping technology, allowing verbal recording and playback of 

compressed audio recordings directly inside your drawings. 
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 Multi-view plan sheet layout (Paper Space), allowing interactive insertion of multiple 2D and 3D 
drawing model views (Model Space) on single or multiple sheets, ready for printing or plotting (full 
support for Paper Space floating viewports). 

 Drawing Explorer for visual management of layers, linetypes, text, blocks, views, coordinate systems. 
 Associative dimensions and cross-hatching with over 100 AutoCAD-compatible hatch styles. 
 Conforms to AutoCAD standards for layers, text, line types, entities and extended entities with direct 

support for AutoCAD SHX, LIN and PAT files. 
 Externally referenced file support, with print and design layout (Paper Space/Model Space) viewing. 
 AutoCAD compatible layer manager, with Ortho/Grid/Snap toggles, and Dynamic snap settings. 
 Comprehensive print/plot facilities, with print previews and named plot style settings 
 Unattended batch plotting and file conversion capabilities. 
 Standard and advanced 2D design and drafting, with user definable hot-keys and shortcuts.  
 Basic 3D design functions, such as 3D coordinate entry and 3D thickness (extrusion). 
 Advanced 3D functions including 3D faces, polyface meshes, boxes, spheres, cylinders, ellipses, 

toruses, tabulated surfaces, ruled surfaces and surfaces of revolution. 
 3D isometric viewing, with 3D auto-rendering tool (ARENDER) for quick rendering of shaded images. 
 DVIEW advanced 3D viewing manager, with perspective, wire-frame and hidden line viewing at user-

specified camera locations. 
 Supports AutoLisp® and ADS® style programming techniques for easy conversion of existing 

applications written for use with AutoCAD. 
 Macro (script) support, with copy and paste creation from commonly used command sequences. 
 PowerSYMBOLS™ (plug-in extension) - over 7,000 professionally drawn 2D/3D symbols dramatically 

speeds creation of architectural, structural, industrial, electronic and interior design drawings. 
 

INSTALLING ALLENCAD PRO 7 

SYSTEM REQUIREMENTS 

AllenCad Pro 7 requires a desktop or laptop computer running Windows 2000, or XP. Hardware 
requirements include: 
 

- Intel® Pentium or equivalent processor (166MHz or faster recommended) 
- Min 32 MB of RAM (64MB or more recommended) 
- 60 - 90 MB of free hard disk space (typical installation) 
- CD-ROM drive (for CD installation only) 
- Internal or external mouse (wheel mouse recommended) or pointing device 

“CONVERTIBLE DEMO” PROGRAM INSTALLATION 

AllenCad Pro 7 can be installed from a downloaded installation file (approx. 32 MB in size) available over 
the Internet at http://adsi-usa.com/techsupport/AllenCAD.html or installed from a AllenCAD “convertible 
demo” CD. Follow the on-screen instructions presented when running the download installation file, or 
when running the CD installation. 
 
All AllenCAD products are automatically installed as a 30-day “convertible demos”, allowing you to 
evaluate the system for 30 days as timed from the moment you install it on your computer for the 
first time. The program will not run past the free trial period, even if uninstalled and reinstalled.  
 
NOTE: Security measures built into the program could cause early termination of your trial if computer 
dates are adjusted during the trial period. Please ensure that your computer date is correctly set 
before program installation. 
 
A valid Product Key is required to activate the system at any time for full and permanent operation. 
Contact ADSI call (800) 258-6360 or visit http://www.adsi-usa.com/ for more information on ordering 
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AllenCad Pro 7. Instructions on how to permanently activate your system will be included with your 
purchase receipt. 

THE TRIAL MODE START SCREEN 

Each time you start the program during the free trial period, a startup screen presents options to: 
 

- Activate your license by purchasing or entering a previously purchased Product Key 
- Upgrade to other AllenCAD products via the Internet 
- Contact ADSI 
- Start the program in demo mode 

 
Using the Start button allows you to try the program free for up to 30 days. The program will not run past 
the free trial period, even if uninstalled and reinstalled.  
 
REMINDER: A Product Key is required to activate the system for permanent operation at any time during 
the free trial period. The trial screen will not appear once you have activated your system using a valid 
Product Key. 

RUNNING ALLENCAD FOR THE FIRST TIME 

Start AllenCAD by clicking on the icon that is placed on your desktop during installation, or by selecting 
the appropriate selection under the AllenCAD program group created under Start>Programs during 
installation. 
 
The following quick start instructions should be used in conjunction with the comprehensive help system 
(F1 or Help menu) and the instruction manuals contained in the /manuals folder after installation. 

THE STARTUP ASSISTANT 

 
 
AllenCAD uses the Startup Assistant to aid in the creation of new drawings or the retrieval of existing 
drawings. Turned ON by default, Startup Assistant options include: 
 

- One button creation of new drawings in imperial or metric units. 
- Startup wizard that guides you through the creation of a new drawing. 
- Start a new drawing using a pre-defined template (known as a prototype drawing in AutoCAD). 
- Open existing DWG, DXF or FLX drawings. 
- View the Startup Assistant help. 
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- Browse your computer for drawings. 
 
Refer to the help system for a full explanation of the Startup Assistant and how to use template drawings. 
 
Note: The Startup Assistant may be called up at any time by typing ASSISTANT at the command line, or 
picking the ASSISTANT icon from the appropriate toolbar. 

MULTIPLE DRAWING CAPACITY 

AllenCad Pro 7 can open an unlimited number of drawings (memory dependent), with multiple views of 
each drawing. AllenCAD Pro gives you the ability to create and save named views, and to create 
print/plot “sheet layouts” containing multiple 2D and 3D views, ready for printing or plotting (referred to as 
Paper Space in AutoCAD). Refer to your online help system for further information.   

OPENING EXISTING FILES 

 
 
When opening existing files using the File Open dialog, options exist to: 
 

1. Select a specific folder on your computer or network (can also use the “Find” button to search). 
2. Display the current drawing file to open. 
3. Select from DWG, DXF or FLX file formats. 
4. Preview drawings (visible only for files that contain a drawing preview). 

CAD FILE EXCHANGE AND COMPATIBILITY WITH OTHER SYSTEMS 

AllenCad Pro 7 features the ability to directly open and save AutoCAD compatible drawings from Release 
12 to the latest Release 2005 DWG and DXF formats. When opening and saving DWG or DXF files, all 
entities are preserved for sharing with AutoCAD and other systems which support these formats.  
 
Refer to the AllenCAD for AutoCAD Users section of the online help for complete details on supported 
and unsupported (but still round-tripped) AutoCAD drawing entities in AllenCad Pro 7. 
 
REMINDER: AllenCad Pro 7 features the ability to publish drawings in lightweight, web and email ready 
DWF format. AllenCad Pro 7 also includes a bonus stand-alone DWF viewer, which can be re-distributed 
to other people in your organization (redistribution restrictions apply). 
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BEING PRODUCTIVE USING ALLENCAD 

GET TO KNOW YOUR ALLENCAD DESKTOP 

 
 
The AllenCAD interface consists of numerous components, including: 
 

- Drawing Title and Current View (number of drawings and view limited only by system memory) 
- Pull-down menu (selectable AllenCAD or AutoCAD-style menus available - custom menus can be 

created using DME2 visual dialog, menu and toolbar editor) 
- Option and Function Toolbars (dockable and customizable using DME2) 
- Properties Bar (quick access to layers, colors and line types with layer manager) 
- Drawing Area (background and other system colors can be changed as desired) 
- Coordinate symbol (or UCS icon), shown in 2D and 3D views (can be turned off if desired) 
- Command Line (expandable and contractible) 
- Status Line (active display of system operations and reference information) 

 
AllenCAD utilizes a 3-way user interface, meaning you can execute commands and system functions 
using one, or a combination of command execution options, including: 
 

- Selecting a function from the pull-down menu. 
- Selecting a function by picking icons from system toolbars. 
- Typing a command, or its 1-3 character shortcut (also known as an alias) at the command line. 
- Entering a series of commands through use of LISP routines or custom macros. 

 
NOTE FOR AUTOCAD USERS: Most AllenCAD commands will be familiar to AutoCAD experienced 
users. AllenCAD recognizes and translates equivalent AutoCAD commands, with the ability to add, edit 
and re-define command “aliases” within the system configuration setting (CONFIG command). 
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RE-CONFIGURE THE DEFAULT DESKTOP TO SUIT YOUR NEEDS 

AllenCAD allows you to quickly and easily alter the default desktop by picking the Configure icon, typing 
“DESKCONF” at the command line, or selecting the Tools>Configure menu selection. You may also click 
your right mouse button while the pointer is situated in a blank area of the toolbar sections to call this 
function. 
 

 
 
Using DESKCONF, options exist to: 
 

- Select the toolbars you want displayed using the Toolbars… selection . 
- Turn the command line and command editor on or off. 
- Control the display of other toolbars 

THE OPTION TOOLBAR 

 
 
The Option toolbar displays all of the available options you have when running any system function. 
Unless you are very familiar with command options, it is recommended you make sure the Option Toolbar 
is turned on to ensure available options are clearly visible as you work. 

SET SYSTEM PREFERENCES TO SUIT THE WAY YOU WORK 

Refer to your online Help system’s Configuration section for a detailed explanation of the many different 
settings, preferences and configuration values you can set within AllenCAD. Although pre-set to offer 
immediate design productivity, a few preferences that you may normally wish to change include: 
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THE CONFIGURATION DIALOG 

AllenCAD’s configuration dialog, which can be called from under the Tools>Configure menu, or by typing 
“CONFIG” at the command line, offers an extensive array of configuration options. 
 
NOTE: Program paths under the Directories tab should only be altered by experienced users. 

Set Your System Colors 

Located under the right-most “Colors” tab in the configuration dialog, options exist to change the 
background color and other desktop colors to suit your preference. 

Set DWG or DXF As The Default Open And Save File Formats 

 
 
Located on the lower right hand section of the “Common” configuration tab, you can change the default 
open and save file types to DWG, DXF or FLX (AllenCAD’s open and flexible file format). 
 

Review, Change, or Add Command Shortcuts (Aliases) 

Located under the middle “Alias Commands” tab in the configuration dialog, options exist to review, 
change and add command shortcuts to improve productivity when typing system commands. By default, 
AllenCAD includes AutoCAD compatible command aliases for the most commonly used functions (e.g. 
“ZW” for Zoom>Window or “L” for the line command). 

Set Hot Keys And Function Keys To Maximize Productivity 

Located under the “Hot Keys” tab in the configuration dialog, options exist to review or change 
assignment of Function keys and other Hot Keys to improve productivity. By default, AllenCAD uses the 
same default Function key assignments as AutoCAD (e.g. pressing F8 toggles ortho mode on or off). 

THE PRECISION SETTINGS DIALOG 
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AllenCAD lets you quickly and easily define your own precision settings to correspond with the drawing 
you are working on. Located under the Tools>Settings menu, or by typing SETTINGS at the command 
line, multiple tabs exist allowing you to set: 
 

- Permanent snap settings to be used as you work, including DynaSnap™ fly-over settings. 
Temporary snaps temporarily override the snap settings you define here. 

- Definition of Snap grids with precise grid and snap value settings. 
- Line and attribute definitions, including arc smoothness, and line thickness and elevation. 
- Construction point style and size. 
- System view parameters, including zoom and pan scales. 
- System edit parameters, including trim, chamfer and default line offset distance. 

 

THE UNITS DIALOG 

 
 
When you start a new drawing, always check to see that the default unit settings for linear and angular 
measurement are correctly specified for the drawing. If you use the same settings (units, layers, line 
types, fonts, title blocks, etc.) for most new drawings, it is recommended you create and use a template 
drawing or series of template drawings to help speed up your work.  
 
The dialog for setting unit parameters can be accessed by typing “UNITS” at the command line, or else 
selecting the “Drawing Setup Parameters…” selection on the Tools pull-down menu. AllenCAD supports 
full imperial or metric operation and retains full-double precision accuracy regardless of the decimal value 
settings used for display and plotting purposes. 
 
NOTE: AllenCAD retains current unit settings with the drawing when saving and re-opening the drawing. 

FOLLOW THE RULES WHEN ENTERING ANGLES AND DISTANCES 

AllenCAD supports all common angular and linear units. Default units are feet, inches and fractions for 
linear measure and degrees, minutes and seconds for angular measure for US English installations. All 
other countries use metric values for default installation settings.  
 
Unless otherwise specified for feet and inch distance entry, input distances will be interpreted as inches 
(i.e. 18 will be interpreted as 18”). Input can be made in either in inches or feet and inches (i.e. 2'5", 29" or 
29 are all considered equal measurements).  
 
There are a number of rules concerning architectural unit entry that you must be aware of: 
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- Hyphens may only be used to separate inch and fraction values (e.g. 5’3-1/4”).  
- Decimal inch values may be used interchangeably with fractional inch entry. 
- Spaces are not permitted – i.e. five feet six and one half inches may be entered as 5’6-1/2" or 

5’6.5" but not 5’ 6 ½". Do not be confused by the fact that the program displays the dimension in 
the latter format, however. 

- Points can be specified in relative coordinate fashion, in exactly the same way as other dimension 
formats. Please refer to the online help file for information on the use of relative coordinate input. 
Also refer to the new ENTERPOINT (shortcut EPT) function, which facilitates dialog-based entry 
of precise coordinate or angle/distance values. 

- When you are specifying fractions, you can use a denominator of any size, however the precision 
factor that you have set under the command “UNITS” will determine the value that the program 
actually reports or displays. 

- Metric and decimal distances use standard decimal unit entry (e.g. 4’6. 21” or 12.315 meters). 

SPEED UP DRAWING CREATION USING ENTERPOINT  

Speed creation of lines, arcs, polylines, etc. by selecting a desired direction with your cross hairs, then 
typing the distance at the command line followed by two “less than” symbols (E.G. 12’<< or 20’6-1/2”<<). 
This is particularly useful when used with Ortho (F8) in drawing lines that are parallel to the coordinate 
axes. 
 

 Alternately, use the new ENTERPOINT function (“ENTPT” shortcut) under the Draw menu while 
running any drawing function (e.g. line, arc, etc.) to quickly and easily define precise absolute or relative 
coordinate, or angle/distance point locations using intuitive dialog-based entry. 
 
NOTE: You must initiate a draw or modify function (eg. LINE) before using ENTERPOINT. 
 

    
ENTERPOINT Coordinate Tab   ENTERPOINT Direction Tab        EnterPoint Option Tab 

UTILIZE THE COMMAND LINE FOR MAXIMUM PRODUCTIVITY 

Most experienced CAD users like to use typed commands (or alias abbreviations) at the command line in 
combination with their mouse to achieve maximum efficiency. The command line constantly relays 
information as you work, including available options while you are running a command. 
 
Make sure to watch the command line and status line carefully for prompts and the command names that 
are called when you pick a menu item or icon to guide in your use of the system. 
 
TIPS: AllenCAD conforms closely to AutoCAD command structure (e.g. you can type “polyline” or the 
alias “pl” to draw a polyline). Pressing F2 will toggle on/off a large screen view of the command line, 
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versus the 5-line default. Aliases can be added or reassigned through the CONFIG command, as 
required. 

CREATE LASER-GENERATED AS-BUILT FLOOR PLANS 

Connect a wired or wireless Leica DISTO™ or a Hilti PD 25/28 handheld laser to a AllenCad Pro 7 
equipped laptop PC to create an automated, mobile design station able to quickly create as-built floor 
plans and construction drawings  

USE VOICENOTES™, REDLINING AND INSPECTION LISTS TO COMMUNICATE PROJECT DATA 

AllenCad Pro 7 includes a number of time-saving markup and collaboration functions, including redlining, 
inspection lists and hands-free VoiceNOTE audio note keeping, letting you quickly and easily 
communicate project change requests and deliver inspection results to other team members. Markups 
can be saved to a unique “redline” layer, and are available for viewing in all mobile and desktop AllenCAD 
products, as well as other CAD systems able to read DWG, DXF or DWF files. Refer to the online help for 
more information. 
 
NOTE: VoiceNOTEs are saved with a visual icon and optional text to ensure visual reference and display 
in non-AllenCAD systems; however a AllenCAD product is required for audio recording and playback. 
 
NOTE: Results are available for viewing by others by saving your drawing in DWF format, and using the 
stand-alone, re-distributable DWF viewer included with AllenCad Pro 7. Redlining, markup, VoiceNOTE 
recording/playback, inspection list management and design editing require the purchase of a AllenCAD 
product which supports more than the view-only capabilities of the DWF viewer.     
  

ADDITIONAL HELP RESOURCES 

This “must read” Getting Started Guide and the built-in AllenCAD Help system are your primary learning 
resources.  
 
If you installed from a CD, additional documentation is contained in the /Manuals folder after installation, 
including comprehensive, print-ready user manuals saved in Adobe Acrobat® PDF format.  
 
All manuals are in the install direction <program files>\Allen Datagraph\AllenCAD\Manuals 
 
NOTE: PDF files require that you have Adobe’s free Acrobat reader installed on your computer, available 
for free download at http://www.adobe.com/products/acrobat/readstep2.html.  
  
Extended help and additional learning resources are available 24 hour/day from our online support center 
at http://www.adsi-usa.com/. Available online resources include: 
 
- Online versions of AllenCAD getting started guides. 
- AllenCAD built-in help system as a downloadable and printable PDF manual. 
- White papers and online demo/training movies for various AllenCAD products. 
- Moderated user forums, where you can post and receive responses to your questions.  
- Online bug and feature request reporting. 
- Information on the latest program updates and service packs.  
 
Each newly licensed AllenCAD user is entitled to an initial period of free startup support through their 
reseller, via email at mailto:support@adsi-usa.com or by calling ADSI at 603-216-6344. To ensure 
continued priority support, annual support contracts are available for very reasonable prices.  

BUG AND WISH LIST REPORTING 

All program bugs and “wish list” items should be sent to: 
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mailto:support@adsi-usa.com  
 
Please make sure to include all pertinent details with attached reference files that pertain to any problem 
encountered. A daytime telephone number should also be included so a technical support representative 
can call to discuss the issue if needed.  
 
We hope you enjoy using AllenCad Pro 7. We welcome your suggestions, comments, and even 
criticisms, as it is only through your input that our software will continue to improve over time.  
 
– Sincerely, Your AllenCAD Development Team 


